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Zu diesem Handbuch

1 Zu diesem Handbuch
1.1 Zweck

Dieses Handbuch erklart lhnen, wie Sie lhren Draco tera installieren,
betreiben und eventuelle Probleme beheben kénnen.

1.2  Gualtigkeit

Dieses Handbuch gilt fir alle auf der Titelseite genannten Geréate. Die
Typenbezeichnung finden Sie auf dem Boden der Geréte.

1.3 Verwendete Symbole
Die folgenden Symbole werden in diesem Handbuch verwendet:

Dieses Symbol kennzeichnet Hinweise, bei deren Nichtbeachtung lhre
Gesundheit, die Funktionsféhigkeit Ihres Geréts oder die Sicherheit lhrer
Daten gefahrdet sind.

Dieses Symbol kennzeichnet Hinweise fur den bestmdéglichen Gebrauch
lhres Geréts.

Dieses Symbol kennzeichnet Hinweise fir vom Hersteller empfohlene
Vorgehensweisen fur eine effektive Ausschdpfung des Gerétepotenzials.

1.4 Schreibweisen

Folgende Schreibweisen finden Sie im Verlauf dieses Handbuchs wieder:

Schreibweise Bedeutung

<Taste> Bezeichnung einer Taste auf der Tastatur

<Taste> + <Taste> Tasten gleichzeitig driicken

<Taste>, <Taste> Tasten nacheinander driicken

2x <Taste> Taste 2x schnell hintereinander driicken
(wie Maus-Doppelklick)

Menupunkt Bezeichnung eines Mentpunkts in der
Software

Menipunkt > Menupunkte nacheinander wéhlen

Menipunkt

Fettdruck Darstellung von verwendeten Begriffen in der
Gerétesoftware
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2 Sicherheitshinweise

Beachten Sie die folgenden MalRBnahmen, um einen sicheren Betrieb Ihres
Draco teras zu gewahrleisten:

Installation

C Verwenden Sie das Gerat ausschlieBlich gemaR dieser
Bedienungsanleitung. Ansonsten kann der vorgesehene Schutz
beeintrachtigt sein.

(@]

Verwenden Sie den Draco tera nur in geschlossenen, trockenen
Raumen.

(@)

Stellen Sie sicher, dass der Raum ausreichend beliftet ist. Der Draco
tera und die Netzteile kbnnen warm werden.

(@)

Stellen Sie sicher, dass vorhandene Beliuftungséffnungen am Geréat
jederzeit frei sind.

(@]

Verwenden Sie ausschlieBlich die original gelieferten Netzteile oder
vom Hersteller freigegebene Ersatzgeréate. Verwenden Sie ein
Netzteil nicht mehr, wenn es den Anschein hat, defekt zu sein oder
wenn das Gehaduse beschéadigt ist.

(@]

Verbinden Sie die Netzteile ausschlie3lich mit geerdeten Steckdosen.
Stellen Sie sicher, dass eine Erdverbindung zwischen der Steckdose
und dem Wechselspannungseingang des Netzteils besteht.

(@]

Sofern das Gerat mit einer oder mehreren Erdungsschrauben
versehen ist, missen diese fur den Normalbetrieb auch verwendet
werden, um die Erdung des Geh&uses sicherzustellen.

(@]

Schliel3en Sie die Gerate nicht Uber das Verbindungskabel an andere
Gerate an, speziell Telekommunikations- oder Netzwerkgeréte.

(@]

SchlieRen Sie an die serielle Schnittstelle nur Geréte an, die im
Fehlerfall ausreichend gegen Kurzschluss-Strome und
Fehlspannungen an der Schnittstelle abgesichert sind.

(@]

Um den Draco tera stromlos zu machen, entfernen Sie bei allen sich
in Betrieb befindlichen Netzteilen das Kaltgeratekabel bzw. setzen Sie
den Netzschalter (falls vorhanden)

C Treffen Sie die erforderlichen ESD-MalRnahmen.

Zur vollstandigen Trennung des Gerats von externen Stromkreisen
missen samtliche Netzkabel entfernt werden.
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Reparatur

(@]

Versuchen Sie nicht, ein Netzteil zu 6ffnen oder zu reparieren.

C Versuchen Sie nicht, den Draco tera zu 6ffnen oder zu reparieren. Er
enthalt keinerlei zu wartende Teile.
C Kontaktieren Sie im Fehlerfall Ihren Lieferanten oder den Hersteller.
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3 Beschreibung

3.1 Verwendungszweck

Die Draco tera-Matrix wird verwendet, um von Konsolen (Monitor,
Tastatur, Maus und andere Peripheriegerate) auf verschiedene Quellen
(Computer, CPU) zu schalten und somit Zugriff herstellen zu kdnnen.

In der maximalen Konfiguration kénnen bis zu 576 unabhéngige Ports
entweder als Quelle oder als Konsole definiert und geschaltet werden.

Die Draco tera-Matrix ist hauptséchlich fur die Verwendung mit Extendern
bestimmt, die Video-, KVM-Signale oder USB-2.0-Signale tibertragen,
kann aber auch als Videomatrix betrieben werden.

Die Verbindung zwischen Matrix und Peripheriegeraten, wie KVM-
Extender oder Videoquellen, erfolgt ausschlielich Giber Cat X-, Glasfaser-
oder Koaxial-Verbindungskabel.

Die Matrix dient gleichzeitig als Repeater. Somit kann die Matrix in einer
maximalen Entfernung von 10 km sowohl von den Konsolen als auch von
den Quellen betrieben werden.

Dies ist eine Einrichtung der Klasse A. Diese Einrichtung kann im
Wohnbereich Funktionsstérungen verursachen. In diesem Fall kann vom
Betreiber verlangt werden, angemessene Maflinahmen durchzufiihren.

Die Sicherheits- und Installationshinweise in dieser Anleitung und die
Empfehlungen zu Lange und Art der Anschluss- und Verbindungskabel
missen eingehalten werden.

3.2  Zugriffsmoglichkeiten

Sie haben folgende Mdéglichkeiten, auf den Draco tera zuzugreifen, um
diesen zu konfigurieren bzw. zu bedienen:

Zugriffsmdglichkeit Symbol
OosD L]
-
05D
Java-Tool

Serielle Schnittstelle
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3.3  System-Ubersicht

Ein Draco tera-Matrix System besteht aus einer Draco tera-Matrix und
einer oder mehreren CPU Units / CON Units. Die Draco tera-Matrix wird
mit Hilfe von Verbindungskabeln an die CPU Units / CON Units
angeschlossen, bzw. direkt an die Quellen und Senken beim Betrieb als
Videomatrix.

Die CPU Units werden Uber die mitgelieferten Anschlusskabel direkt an
die Quellen (Computer, CPU) angeschlossen.

Monitor(e), Tastatur und Maus werden an die CON Units angeschlossen.

Die Kommunikation zwischen der Draco tera-Matrix und den CPU Units /
CON Units findet tber die jeweiligen Verbindungskabel statt.

= -

m = -

- — B

m T =

1 2 3 4 3 5

System-Ubersicht

Quelle (Computer, CPU)
CPU Units
Verbindungskabel
Draco tera-Matrix

CON Units

o OO WN P

Konsole (Monitor, Tastatur, Maus)

o Installationsbeispiele finden Sie im Kapitel 4.3, Seite 58.
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3.4

3.5

Geratetypen

Typ Beschreibung

K480-576 Draco tera-Matrix mit 576 Ports, leer, freie
Bestiickung

K480-576S Draco tera-Matrix mit 576 Ports (288x288), leer,
freie Bestlickung

K480-288 Draco tera-Matrix mit 288 Ports, leer, freie
Bestiickung, Vorbereitung fir redundante CPU-
Karte

K480-160 Draco tera-Matrix mit 160 Ports, leer, freie
Bestiickung

K480-152 Draco tera-Matrix mit 152 Ports, leer, freie
Bestlickung, Vorbereitung fir redundante CPU-
Karte

K480-080 Draco tera-Matrix mit 80 Ports, leer, freie
Bestuickung, Vorbereitung fur redundante CPU-
Karte

K480-048 Draco tera-Matrix mit 48 Ports, leer, freie
Bestuckung, Vorbereitung fur redundante CPU-
Karte

Zubehor

Typ Beschreibung

480-C8R1 Draco tera Cat X E/A-Karte, Revision 1

480-S8R1 Draco tera Glasfaser E/A-Karte Single-Mode,
Revision 1

480-C8X Draco tera Cat X, 3,125 Ghit/s (XV)

480-S8X Draco tera Glasfaser E/A-Karte Single-Mode,
3,125 Gbit/s (XV), Revision 1

480-UNI16 Draco tera Uni-E/A-Karte fir USB 3.0 und SDI

480-GRD-S8-R1

Draco tera 8 zu 1-Port Matrix-Grid Karte (8 Grid
Verbindungen), Single-Mode, 1,4 km

480-CTRL Draco tera CPU-Karte Version 1
480-CTRL2 Draco tera CPU-Karte Version 2
480-C8BDG Draco tera Cat X E/A-Karte fur die Wandlung von

1G auf 3G (XV) Signalen (nur fur CPU Units)

14
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Typ Beschreibung

480-S8BDG Draco tera Glasfaser E/A-Karte Single-Mode fir die
Wandlung von 1G auf 3G (XV) Signalen (nur fir
CPU Units)

436-IECLOCK-EU | IEC-Anschlusskabel zur Spannungsversorgung,
verriegelbar, EU-Stromstecker

436-IECLOCK-US | IEC-Anschlusskabel zur Spannungsversorgung,
verriegelbar, US-Stromstecker

459-1C Cat X GBIC zum Einsatz im Draco tera

459-1S Single-Mode GBIC, LC-Duplex, bidirektional, zum
Einsatz in Draco minor / major / tera

459-1V Single-Mode GBIC, LC-Duplex, bidirektional, zum
Einsatz im Draco tera (3,125 Ghit/s)

459-6M Multi-Mode GBIC, LC-Duplex, bidirektional, zum
Einsatz im Draco tera fir USB 3.0 (6,25 Gbit/s)

459-10S10 Single-Mode GBIC, LC-Duplex, birektional, zum

Einsatz in Matrix-Grid E/A-Karten (10 Gbhit/s),
Distanz 10 km

459-3BX Koaxial GBIC, bidirektional, zum Einsatz im Draco
tera (3G-SDI)

459-3DX Mini-DIN 1.0/2.3 GBIC, bidirektional, zum Einsatz
im Draco tera (3G-SDI)

459-3FX Single-Mode GBIC, LC-Duplex, bidirektional, zum
Einsatz im Draco tera (3G-SDI)

459-BMB Adapterkabel von BNC nach HD-BNC um
Standard-BNC-Kabel mit HD-BNC-SFPs zu
verbinden

459-BMD Adapterkabel von BNC nach Mini-DIN um
Standard-BNC-Kabel mit Mini-DIN-SFPs zu
verbinden

480-FAN576 Draco tera 576 Luftereinschub (Ersatzteil)

480-FAN160 Draco tera 288/160/152 Liftereinschub (Ersatzteil)

480-FANS8O Draco tera 80 Luftereinschub (Ersatzteil)

480-FAN48 Draco tera 48 Liftereinschub (Ersatzteil)

480-RED576 Draco tera 576 Einschubnetzteil als Ersatz oder fiir
Upgrade zu redundanter Stromversorgung

480-RED288 Draco tera 288 Einschubnetzteil als Ersatz oder fiir

Upgrade zu redundanter Stromversorgung
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Typ Beschreibung

480-RED160 Draco tera 160/152 Einschubnetzteil als Ersatz
oder fur Upgrade zu redundanter Stromversorgung

480-RED80O Draco tera 80/48 Einschubnetzteil als Ersatz oder
fur Upgrade zu redundanter Stromversorgung

480-FLTR576 Draco tera 576 Filtermatten als Verbrauchsmaterial

480-FLTR160 Draco tera 288/160/152 Filtermatten als
Verbrauchsmaterial

480-FLTR80 Draco tera 80 Filtermatten als Verbrauchsmaterial

480-FLTR48 Draco tera 48 Filtermatten als Verbrauchsmaterial
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Beschreibung

3.6 Geréateansichten

Die folgenden Ansichten der Draco tera-Matrix stellen die aktuell
verfiigbaren Gehausevarianten dar:

3.6.1 Draco tera 576 Port
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Einschub fur Netzteil 1

Einschub Lufterkassette 1
Einschub fur Netzteil 2
Einschube fur E/A-Karten #1i 36
Einschub fur Lifterkassette 2
Einschub fur Netzteil 3
Einschibe fur E/A-Karten #37i 72
Einschub fur Netzteil 4

© 00 N o 0o b~ W N PP

Erdung
10 Einschub fur CPU-Karte 1
11 Einschub fur CPU-Karte 2
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Draco tera 288 Port

3.6.2
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Einschub fur Netzteil 1
Einschub Lufterkassette 1
Einschub fur Netzteil 2
Einschub Lufterkassette 2
Einschube fur E/A-Karten #1i 36
Einschub fur Netzteil 3

Erdung

Einschub fir CPU-Karte

0o N o g b WN P
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3.6.3 Draco tera 160 Port

Einschub Lifterkassette 1
Einschiibe fur E/A-Karten #17 20
Einschub fiur Netzteil 3

Einschub fir Netzteil 2
Einschub Lifterkassette 2
Einschub fir CPU-Karte

Einschub fir Netzteil 1

Erdung

Vorderseite

1
2
3
4
5
6
7
8
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3.6.4 Draco tera 152 Port
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Einschub fur Netzteil 1

Einschub Lufterkassette 1

Einschub fir Netzteil 2

Einschub Lufterkassette 2

Einschibe fur E/A-Karten #11 20
Einschub fiir Netzteil 3

Erdung

Einschub fir CPU-Karte (Redundanz)
Einschub fir CPU-Karte
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3.6.5 Draco tera 80 Port
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Einschub Lifterkassette 1
Einschub fur Netzteil 1
Einschibe fur E/A-Karten #11 10
Einschub fur Netzteil 2
Einschub fur CPU-Karte
Einschub fur Luftfilter

~N o o~ W NP

Einschub Lifterkassette 2
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3.6.6

Draco tera 48 Port
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Einschub Lifterkassette 1

Einschub fir Netzteil 1

Einschiibe fur E/A-Karten #1i 6

Einschub fur Netzteil 2
Einschub fir CPU-Karte
Einschub fir Luftfilter

Einschub Lifterkassette 2
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3.7 Diagnose und Status
3.7.1 Diagnose LEDs

Der Draco tera ist mit folgenden LEDs zur Statusanzeige ausgestattet:

CPU-Karte

lT of . NN b

Vorderseite
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Diagnose LEDs der CPU-Karte

Pos. | LED Zustand | Bedeutung
1 Status 1 Weil3 CPU-Karte wird initialisiert
Blau Anmeldung an Matrix wird gestartet
blinkend
Rot Anmeldung lauft
blinkend
Griin Betriebszustand
blinkend
Griin CPU-Karte abgemeldet
2 Status 2 Weil3 CPU-Karte wird initialisiert
Rot Anmeldung an Matrix wird gestartet
blinkend
Aus Betriebszustand

Aufgrund von unterschiedlichen LED-Typen kann "weif3" auch als
"hellblau" oder "hellviolett" wahrgenommen werden.
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E/A-Karte

SFP Koax Matrix-Grid

SFP Glasfaser

Cat X
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Draco tera

Diagnose LEDs der E/A-Karten

Pos. | LED Zustand | Bedeutung

1 Status 1 Tarkis E/A-Karte im Bootvorgang
Rot E/A-Karte wird angemeldet
blinkend

Rot/Gelb | E/A-Karte befindet sich im Service-
blinkend | Mode oder Firmware-Konflikt mit der
CPU-Karte

Grin Betriebszustand, E/A-Karte an Matrix
blinkend | angemeldet

Griin E/A-Karte abgemeldet
(Verriegelungsstift herausgezogen)

2 Status 2 Weil3 E/A-Karte im Bootvorgang

Blau E/A-Karte wird angemeldet

Blau Betriebszustand, Kommunikation mit
blinkend | CPU-Karte aktiv

Rot E/A-Karte abgemeldet

blinkend | (Verriegelungsstift herausgezogen)
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Ports E/A-Karte

Cat X SFP Glasfaser
0O 0 g o
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1— i
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SFP Koax Matrix-Grid
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Vorderseite
1 Diagnose-LED 1
2 Diagnose-LED 2

Diagnose LEDs an Ports der E/A-Karten

Pos. | LED Zustand | Bedeutung
1 Link Status | Aus Port abgeschaltet
(orange) Blinkt Port eingeschaltet, keine Verbindung
Uber das Verbindungskabel
2 Link Status | Aus Port abgeschaltet
(grun) An Verbindung tiber das Verbindungskabel

ok, Datenverkehr aktiv
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Lufterkassette

——FAN TRAY ——

1 2 3
Vorderseite

1 Diagnose-LED 1
2 Diagnose-LED 2
3 Hot-Swap-LED

Diagnose LEDs der Lifterkassetten

Pos. | LED Zustand | Bedeutung

1 Status 1 An Betriebszustand
(gran)

2 Status 2 Aus Betriebszustand
(rot) An Fehlermeldung

3 Hot Swap Aus Hot Swap deaktiviert (optional)
(blau) An Funktion aktiviert
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Netzgerat Draco tera 576

L J
W

Vorderseite

Diagnose LEDs der Netzteile

Pos. | LED Zustand | Bedeutung

1 Status LED | Grin Stand-by an;
Hauptausgangsspannung verflugbar

Orange | Hauptausgangsspannung OCP oder
UVP oder OVP

Orange | Lufterfehler; Temperatur Uber
blinkend | Normalwert
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Netzgerat Draco tera 288/160/152

°.

123
Vorderseite

Diagnose LEDs der Netzteile

Pos. | LED Zustand | Bedeutung
1 AC Input An Betriebszustand
OK (griin)
2 DC Qutput |An Betriebszustand
OK (griin)
3 O/T (gelb) Aus Betriebstemperatur
An Temperatur Uber Normalwert

Netzgerat Draco tera 80/48

O

O

Vorderseite

Pos. | LED Zustand | Bedeutung
1 DC Input On Betriebszustand
OK (gruin) Off Keine Spannungsversorgung
DC Input On Netzteil nicht aktiv, Matrix wird tiber
(rot) zweites Netzteil versorgt
Off Betriebszustand

32
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3.7.2

Port-Status

In diesem Meni werden Ihnen die Verbindungen und die Schaltzustédnde
zwischen den verschiedenen Konsolen und CPUs angezeigt.

Sie haben folgende Mdglichkeit das Menu aufzurufen:

Java-Tool

In diesem Men wird die aktuelle Portbelegung des Draco tera grafisch
dargestellt.

C Wihlen Sie im Aufgabenbereich des Online-Modus View > Matrix.
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Menu View i Matrix (Beispiel 1)
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L insa
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Menu View i Matrix (Beispiel 2)

Folgende Farbcodierungen stehen zur Auswabhl:

Farbe Bedeutung

Grau Port ist nicht verbunden

Gelb Videoverbindung

Grin KVM-Verbindung

Rot Fehlerhafter Port

Blau Port Giber eine Grid-Line mit anderer Matrix
verbunden

Folgende Symbole geben den am Port erkannten bzw. definierten

Extender wieder:

Symbol

Bedeutung

Port ist an eine CPU Unit angeschlossen.

]

Port ist an eine CPU Unit angeschlossen, die im
Private Mode auf eine CON geschaltet ist (siehe
Kapitel 3.7.4, Seite 38).

34
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Symbol Bedeutung

Port ist an eine CON Unit angeschlossen.

Port ist an eine CON Unit angeschlossen und Uber
Shared Access zusammen mit mindestens einer
weiteren Konsole auf dieselbe CPU verbunden.

Port ist an eine CON Unit angeschlossen, die im
Private Mode auf eine CPU geschaltet ist (siehe
Kapitel 3.7.4, Seite 38).

Port ist an eine USB 2.0 CPU Unit angeschlossen.

Port ist an eine USB 2.0 CON Unit angeschlossen.

Port ist als Cascade-CON-Port zur Kaskadierung von
Matrizen definiert.

Port ist als Cascade-CPU-Port zur Kaskadierung von
Matrizen definiert.

Port ist ein UNI-Port einer E/A-Karte, Uber den USB-
3.0- oder SDI-Signale geschaltet werden kénnen.

UNI-Port ist als CON-Port konfiguriert, z. B. zum
Anschluss von USB-3.0-CON-Extendern.

UNI-Port ist als CPU-Port konfiguriert, z. B. zum
Anschluss von USB-3.0-CPU-Extendern.

- Rot umrandete Ports sind "fix" definierte Ports (z. B. fir USB-2.0-
Verbindungen).
Der mit vier blauen statischen Selektionsquadraten markierte Port ist
aktuell ausgewahlt.
Wird ein Port markiert, werden alle anderen Ports transparent
angezeigt, mit Ausnahme derjenigen Ports, welche mit dem aktuell
selektieren verbunden sind. Eine Markierung lasst sich durch
Betétigen des Buttons Clear Selection aufheben.
Wird bei einem Schaltvorgang Uber die Matrix View ein Port mit
einem roten Kreuz dargestellt, so hat die zu verschaltende Konsole
momentan keine Zugriffsrechte auf die entsprechende CPU an
diesem Port.

Um fur den aktuell selektierten Port im rechten Teil des
Arbeitsbereichs Extender-Informationen einzublenden, driicken Sie
die linke Maustaste.

(@]
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Folgende Angaben finden Sie in diesem Menu:

Feld Bedeutung

Extender Name | Name des ausgewahlten Extenders

Extender Type | Art des ausgewdhlten Extenders

Port ID Nummer des ausgewahlten Ports

Device Name Name der verbundenen Konsole bzw. CPU

Connections Auflistung der zum Port zugeordneten Verbindungen
(Full Access oder Video Access)

C Um fir den aktuell selektierten Port das Kontextmenii mit
weiterfiihrenden Funktionen zu 6ffnen, driicken Sie die rechte
Maustaste.

Folgende Kontextfunktionen finden Sie in diesem Meni:

Funktion Bedeutung

Open Extender | Men( zur Definition der aktuell ausgewéahlten
Extender 6ffnen

Open Device Menu zur Definition der aktuell ausgewéahlten Konsole
oder CPU offnen
Switch Meni zur Durchfuhrung von Schaltvorgéngen 6ffnen

Fur die Aktualisierung der Matrix View stehen lhnen folgende
Mdoglichkeiten zur Verfigung:

Driicken der Taste <F5> einer angeschlossenen Tastatur
Ausfuihren von Edit > Reload in der Mentileiste

Driicken des Buttons Reload in der Symbolleiste
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3.7.3 Port-Status Matrix-Grid

In diesem Meni werden Ihnen die Verbindungen und die Schaltzustédnde
zwischen den verschiedenen Konsolen und CPUs innerhalb eines Matrix-
Grids angezeigt.

Die Port-Ansicht ist in die verschiedenen Grid-Matrizen untergliedert.
Dabei wird jede Matrix in einer optimierten Darstellung mit 24 Ports je
Zeile angezeigt, um auch eine grof3e Anzahl an Ports abbilden zu kénnen.

Sie haben folgende Md&glichkeit das Meni aufzurufen:

| ,"

44\\-»\
Java-Tool

In diesem Menii wird die aktuelle Portbelegung des Matrix-Grid grafisch
dargestellt.

C Wihlen Sie im Aufgabenbereich des Online-Modus View > Port.
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Meni View i Port

sind identisch zum Port-Status der Matrix View siehe Kapitel 3.7.2,
Seite 33.

0 Die in der Grid Port View verwendeten Funktionen, Farben und Symbole
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3.7.4 Extender-OSD

Alle am Draco tera betriebenen Draco Extender sind werksseitig mit
einem eigenen OSD zur Darstellung des Verbindungsstatus ausgestattet.

CON 010146888/

Beispielansicht Extender OSD

Folgende Angaben finden Sie im OSD-Menu:

Feld

Bedeutung

CON

Bezeichnung der eigenen Konsole

CPU

Bezeichnung der aktuell aufgeschalteten CPU
Farbcodierung:

Grin: Die Verbindung zur ausgewéhlten CPU konnte
vollstandig hergestellt werden.

: Die Verbindung zur ausgewéahlten CPU konnte
nur teilweise hergestellt werden.

Rot: Die Verbindung zur ausgewéahlten CPU konnte
nicht hergestellt werden.

Hinweis: Mdgliche Grunde fir eine unvollstéandige oder
nicht ausgefuihrte Verbindungsherstellung sind
ausgeschaltete Extender oder nicht ausreichend
vorhandene Grid-Lines im Matrix-Grid-Betrieb. Sofern
keine Grid-Lines flr die Verschaltung verfugbar sind,
erscheint zuséatzlich noch die Meldung No more grid lines
available.

38
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Feld Bedeutung

ACCESS - Full Access: Die eigene Konsole hat mit der
angezeigten CPU eine KVM-Verbindung.

: Die eigene Konsole hat mit der
angezeigten CPU eine reine Video-Verbindung.
Private Mode: Die eigene Konsole hat mit der
angezeigten CPU eine Private-Mode-Verbindung.
not connected: Die eigene Konsole ist nicht mit einer
CPU verbunden.

SHARED x device(s) zeigt die momentane Anzahl an Devices an,
die im Moment ebenfalls eine Verbindung zur aktuell
verbundenen CPU der eigenen Konsole haben (z. B.

3 Devices).

Wenn das Feld leer bleibt, existiert nur die eigene
Verbindung zur aktuellen CPU.

Kapitel 5.4.4, Seite 100) verwendet, wird bei den Konsolen, die aktuell
keine Kontrolle besitzen, im Extender-OSD unter Access diejenige
Konsole in gelb angezeigt, welche aktuell K/M-Kontrolle besitzt.

0 Werden die Optionen Mouse Connect bzw. Keyboard Connect (siehe

3.7.5 Netzwerk-Status
In dieser Ansicht wird lhnen die aktuelle Netzwerk-Konfiguration
angezeigt.
Sie haben folgende Mdglichkeiten das Menu aufzurufen:
|

pE— o

05D

Folgende Angaben finden Sie in diesem Meni:

Feld Bedeutung

DHCP Anzeige, ob die Netzwerk-Einstellungen dynamisch
bezogen werden. Anzeige Y (Yes) oder N (No)

IP Address Anzeige der IP-Adresse, wie eingegeben bzw. per
DHCP bezogen

Subnet Mask Anzeige der Subnet Mask, wie eingegeben bzw.
per DHCP bezogen

Gateway Anzeige der Gateway-Adresse, wie eingegeben
bzw. per DHCP bezogen

MAC ID Anzeige der MAC-Adresse der Matrix
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OsD
C Wahlen Sie im Hauptmenii Status > Network.
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Meni Status T Network
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Java-Tool

1. Wabhlen Sie im Aufgabenbereich View > Matrix.
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Meni View T Matrix
2. Klicken Sie mit der linken Maustaste auf den Netzwerk-Port der CPU-
Karte.

Der dazugehorige Netzwerk-Status erscheint im rechten Teil des
Arbeitsbereichs.

Die verfligbaren Informationen lassen sich durch Driicken der linken
Maustaste auf das "Plus"- bzw. "Minus"-Symbol ein- bzw. ausblenden.
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3.7.6 Firmware-Status Matrix

In diesem Meni wird der Firmware-Status der eingebauten Karten

angezeigt.

Sie haben folgende Mdglichkeiten das Menii aufzurufen:

Folgende Angaben finden Sie in diesem Menu:

Feld

Bedeutung

Name

Bezeichnung des Moduls

Type

Typennummer

Ports

Anzahl der Ports

Version

Vollstéandige Beschreibung der Firmware-Version

Date

Datum der Firmware-Version

Status

Kartenstatus

42
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OsD
C Wahlen Sie im Hauptmenii Status > Firmware.

Firmware

MATKB48c CPU 1 FO3.08 23.01.20

001 MATXKCAT T08 8 FB3.08 23.01.20
002 MATXCAT 108 8 FB3.08 23.01.20

[syrchor:  [raco tera]
Meni Status 7 Firmware
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Java-Tool
1. Wabhlen Sie im Aufgabenbereich Status & Updates > Status - Matrix

Firmware.
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Meni Status & Updates - Status - Matrix Firmware

2. Um den Gesamtstatus der Matrix auszulesen und lokal
abzuspeichern (Dateiendung .zip), wéhlen Sie Device > Save Status
oder driicken Sie den entsprechenden Button in der Symbolleiste.

Die verschiedenen Module lassen sich durch einen Klick mit der linken
Maustaste auf die "Plus"- und "Minus"-Symbole in der Spalte Name auf-
und einklappen.

Durch Klicken auf das "Plus"- bzw. "Minus"-Symbol in der rechten oberen
Ecke des Arbeitsbereichs kdnnen Sie mit einem Klick der linken
Maustaste alle Modulinformationen aus- und einklappen.
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3.7.7 Firmware-Status Extender

In diesem Meni wird der Firmware-Status der angeschlossenen Extender
angezeigt.

Sie haben folgende Mdglichkeit das Menu aufzurufen:

Folgende Angaben finden Sie in diesem Menu:

Feld Bedeutung

Name Bezeichnung des Firmware

Type Bezeichnung des Extenderbausteins

Ports Anzahl der Ports

Cur. Version Bezeichnung der aktuellen Firmware-Version
Cur. Date Datum der aktuellen Firmware-Version

C Wihlen Sie im Aufgabenbereich Status & Updates > Status -
Extender Firmware.

| insea

MenUl Status & Updates - Status - Extender Firmware
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3.8 Funktion Trace

In diesem Meni werden samtliche Aktivitdten und Schaltvorgdnge der
Draco tera-Matrix protokolliert und aufgezeichnet.

Diese Funktion dient zu Diagnosezwecken.

Sie haben folgende Mdglichkeit das Menu aufzurufen:
=

OsD

Folgende Angaben finden Sie in diesem Menii:

Feld Bedeutung

Date Datumsstempel

Time Zeitstempel

Message Genaue Beschreibung des Ereignisses

Trace-Moglichkeiten

C Um die Ereignisse der Matrix zu iiberwachen, wéhlen Sie im
Hauptmeni Status > Trace.
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3.9 Syslog Monitoring

In diesem Men findet eine komplette Protokollierung der Draco tera-
Matrix hinsichtlich Aktivitdten, Schaltvorgangen und der Uberwachung
funktionskritischer Komponenten, wie z. B. Lifter oder Netzteile, statt.

Sie haben folgende Mdglichkeit, das Menu aufzurufen:

Um das Syslog Monitoring zu starten, gehen Sie wie folgt vor:
C Wihlen Sie in der Symbolleiste das Symbol Monitoring.

=W+ = ¥ § TYE 8w m W hse
Ii;.-ﬂ.ﬂ‘l ..... . B . = -

e -
i ol |

Menl Monitoring 1 Syslog

Die Protokollierung der Systemaktivitaten beginnt mit dem Aufruf des
Menls Monitoring und bleibt so lange aktiv, bis der dazugehérige Tab
geschlossen wird.

Syslog-Meldungen werden Uiber UDP gesendet. Hierzu darf der Port 514
innerhalb des verwendeten Netzwerks nicht geblockt werden, z. B. durch
eine Firewall.
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Wahrend der Protokollierung wird diese fortlaufend in Protokolldateien
geschrieben und lokal abgespeichert. Dieser Vorgang kann mit
verschiedenen Optionen versehen werden.

Optionen

C Wabhlen Sie in der Meniileiste Extras > Options und &ffnen Sie den
Tab Syslog.

Folgende Optionen stehen zu Auswahl:

Option Bedeutung

Log File Directory | Standardverzeichnis, in welches die
Protokolldateien gespeichert werden

Log File Name Standardname der zu speichernden Protokolldatei

Log File Extension | Standardendung der Protokolldatei

Daily Logfiles Protokolldateien werden im 24-Stunden-
Rhythmus erstellt (taglich)

Maximum Log File | Erlaubte Maximalgrof3e der Protokolldatei

Size (KB)
Maximum Number | Erlaubte Maximalzahl an Protokolldateien
of Log Files
Autostart Beim Offnen des Java-Tools wird die Syslog-
Funktion im Hintergrund gestartet
Open Monitoring Beim Offnen des Java-Tools wird der Monitoring-
Tab Tab geoffnet.
Ist die MaximalgrofR3e einer Protokolldatei erreicht, so wird eine neue
Protokolldatei angelegt. Ist die maximale Anzahl an Protokolldateien

erreicht, wird die alteste Protokolldatei mit den neuen Informationen
Uberschrieben.

Filterfunktion

Um aus der Vielzahl an protokollierten Aktivitaten des Draco tera
relevante Meldungen herauszufiltern, bietet das Syslog Monitoring
verschiedene Filteroptionen.

Um einen Filter einzustellen und zu aktivieren, gehen Sie wie folgt vor:

1. Setzen Sie die gewiinschte(n) Filteroption(en) durch Aktivieren der
jeweiligen Checkbox.

Aktivieren Sie die Filteroptionen durch Driicken des Buttons Filter.

Um einen aktivierten Filter zu deaktivieren, driicken Sie den
Button Clear.
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Folgende Filteroptionen stehen zur Auswahl:

Option Bedeutung

Date Meldungen eines definierten Datumsbereichs
werden gefiltert

Facility Meldungen eines definierten Betriebsbereichs
werden gefiltert

Severity Meldungen einer definierten Gewichtung einer
Meldung werden gefiltert

Host Meldungen eines definierten Hosts werden
gefiltert

Message Meldungen mit definierten Textteilen werden
gefiltert

In den lokal abgespeicherten Protokolldateien sind die Filteroptionen
unwirksam.

Aufzeichnungsfunktion

Die im Syslog dargestellten Meldungen sind mit verschiedenen
Aufzeichnungsoptionen versehen, um diese zu bearbeiten.

C Um die im Syslog dargestellten Meldungen (gefiltert oder ungefiltert)
zu speichern, driicken Sie den Button Save trace. Die Meldungen
werden in einer .txt-Datei gespeichert.

C Um die im Syslog dargestellten Meldungen zu entfernen, driicken Sie
den Button Clear trace.
C Um die Aufzeichnung der Meldungen anzuhalten, driicken Sie den
Button Pause. Um die Pause zu beenden, driicken Sie den Button
erneut.
3.10 SNMP

Mit der SNMP-Funktion kénnen alle funktions- und sicherheitskritischen
Bestandteile der Matrix Glberwacht und zu jeder Zeit deren Status
abgefragt werden. Diese Funktion entspricht einem RFC 1157-konformen
Standard.

Fur die Uberwachung mittels SNMP wird aus Griinden der
Zugriffssicherheit die Verwendung eines dedizierten Netzwerks gemal IT-
Grundschutz-Katalog empfohlen. Die Read-Only-Community fur die MIB
lautet draco.

2020-02-26 49



Draco tera

Sie haben folgende Mdglichkeiten, Einstellungen fiir die SNMP-
Uberwachung vorzunehmen:

osD
Um den SNMP-Agenten zu aktivieren, gehen Sie wie folgt vor:
1. Wabhlen Sie im Hauptmenl Configuration > SNMP.

CON 010196841 (1560/0)

SHHMP Agent
NO

SHHP Server
NO NO
000.000.0060 . 000 000.000.0060 . 000

NO NO
NO NO

NO NO
NO NO
NO NO

NO NO
NO NO

Meni Configuration i SNMP

2. Setzen Sie unter SNMP Agent die Option Enable auf Y (Yes). Durch
Aktivierung dieser Option wird die Erlaubnis zur aktiven Abfrage des
SNMP-Agents erteilt.

Um einen SNMP-Server zu konfigurieren, gehen Sie wie folgt vor:
1. Wabhlen Sie im Hauptmen( Configuration > SNMP.

2. Setzen Sie unter SNMP Server die Option Enable Traps auf Y (Yes).
Dadurch wird das aktive Senden von Trap-Meldungen vom SNMP-
Agent an den SNMP-Server ermdglicht.
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setzen.

Beschreibung

Setzen Sie unter Server Address die IP-Adresse des SNMP-

Aktivieren die gewiinschten Traps, indem Sie diese auf Y (Yes)

Folgende Traps stehen zur Auswahl:

Trap Bedeutung
Status Benachrichtigung tber den Matrix-Status
Temperature Benachrichtigung Uber die Temperatur innerhalb

der Matrix

Insert Board

Benachrichtigung tber den Einschub einer neuen
E/A-Karte in einen Slot

Remove Board

Benachrichtigung tber das Entfernen einer E/A-
Karte aus einem Slot

Invalid Board

Benachrichtigung ber eine nicht ordnungsgeman
funktionierende E/A-Karte

Insert Extender

Benachrichtigung tber einen neu an der Matrix
angeschlossenen Extender; Benachrichtigung
Uber einen angeschalteten Extender;
Benachrichtigung Uber einen neu hergestellten
Link zwischen Extender und Matrix

Remove Extender

Benachrichtigung tber einen von der Matrix
entfernten Extender, Benachrichtigung uber einen
ausgeschalteten Extender; Benachrichtigung Uber
einen getrennten Link zwischen Extender und
Matrix

Switch Command

Benachrichtigung tber eine an der Matrix
durchgefihrte Schaltung

Fan Tray #1 Benachrichtigung tber den Status der
Lufterschublade #1

Fan Tray #2 Benachrichtigung tber den Status der
Lufterschublade #2

Power Supply #1

Benachrichtigung tber den Status von Netzteil #1

Power Supply #2

Benachrichtigung tber den Status von Netzteil #2

Power Supply #3

Benachrichtigung Uber den Status von Netzteil #3

Power Supply #4

Benachrichtigung tiber den Status von Netzteil #4
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0

Um den SNMP-Status abzufragen, gehen Sie wie folgt vor:
C Wihlen Sie im Hauptmeni Status > SNMP.

Fur eine Aktivierung der SNMP-Agent-Funktion oder der SNMP-Servers-
Funktion ist ein Neustart der Matrix erforderlich.

Es kdnnen zwei SNMP-Server gleichzeitig verwendet werden.

Java-Tool
Um den SNMP-Agenten zu aktivieren, gehen Sie wie folgt vor:

1. Wabhlen Sie im Aufgabenbereich System Settings > Network.

——— e
i e S
L el
- ———

) Covrns S b e

Menl System Settings - Network

2. Aktivieren Sie im Tab SNMP die Option SNMP Agent. Durch
Aktivierung dieser Option wird die Erlaubnis zur aktiven Abfrage des
SNMP-Agents erteilt.
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Um einen SNMP-Server zu konfigurieren, gehen Sie wie folgt vor:
1. Wahlen Sie im Aufgabenbereich System Settings > Network.

2. Aktivieren Sie unter SNMP Server die Option Enable Traps. Dadurch
wird das aktive Senden von Trap-Meldungen vom SNMP-Agent an
den SNMP-Server ermdglicht.

3. Setzen Sie unter SNMP Server die IP-Adresse des SNMP-Servers.
4. Aktivieren die gewlinschten Traps.

Fur eine Aktivierung der SNMP-Agent-Funktion oder der SNMP-Server-
Funktion ist ein Neustart der Matrix erforderlich.

3.11 System Check

Der System Check bietet eine Diagnosefunktion zur Uberprifung Ihrer
aktuellen Matrix-Konfiguration. Er dient dazu, nicht optimale sowie
fehlerhafte Einstellungen aufzudecken und darauf hinzuweisen.

Der System Check dient ausschlieRlich zur Plausibilitatsprifung und
nimmt keine aktiven Konfigurationséanderungen vor.

Sie haben folgende Mdglichkeit, das Meni aufzurufen:

Folgende Konfigurationsbestandteile werden untersucht:
Matrix-Firmware
Extender-Firmware
Multi-Screen Control
Ext Units
CPU Devices
CON Devices
User
System Configuration
Matrix Grid
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Folgende Benachrichtigungslevel kdnnen angezeigt werden:

Level Bedeutung

OK (gruin) Uberprifung der Konfiguration ohne
Auffalligkeiten abgeschlossen.

WARNING (gelb) Uberprifung ergab Auffalligkeiten in der
Konfiguration, die auf unvollstandige
Konfigurationsbestandteile, Unterschiede bzgl.
Firmware, Duplizierungen oder nicht
angeschlossene Extender hinweisen, allerdings
nicht systemkritisch sind.

ERROR (rot) Uberpriifung ergab Fehler in der Konfiguration,
die sowohl funktions- als auch stabilitatskritische
Auswirkungen auf das System haben kénnen.

Sofern die Meldungen "WARNING" bzw. "ERROR" im System Check
ausgeldst werden, wird das jeweilige Problem dort beschrieben und eine
Handlungsanweisung ausgegeben.

Um den System Check zu starten, gehen Sie wie folgt vor:
C Wihlen Sie in der Symbolleiste das Symbol System Check.

| Systern Ok - OV DVES
|
| Systeen Cach .
| The SpaemOnacs betps 12 350066 POGERN @ SOM0EE OF e0r0r Wity Fia COMDUalen of Bw mualte Tad (eiuds 306 bSlad 2 seCommen el o0 0

| ordee % sappart voor peesonal Greck of e condguraton

Maie Firowore

50 MWL W0 CONY
s Q50 B
| Extencer ¥ mrwere Extonder fimware versiar <
sk Zn B i Shates - Lxlenchar Fammaere.

| System Comtguraton

| Wk Screen Comesl

| Pers

| Gng Ly Iz 2819 COOLE e Ly 1 e

| EXTums (C%) FATOR Of Gria oS In COTNEReN 182
EXT Umrs EAT Lol with ot dwace 200 0t

JLE2 Marme = Vaes T are )
HEoTROtin Exoener & Devices > CON Devicos
| exr umas R L T Trm—
| 0= 40121223 Mame = CPU_F1_4K_1G

- N sangrvrwod in L ttenter & Devices » CPU Cwvicen.

| FXT Urstx §amtenaeie] weh port rumter T dyecies
| = CNOCs Eedn S6f18! o) 200 U0 27 1 Extieeder € Devices » EXT Ueis
CPU Davicen Inh Nt of CPU Depcas in comigursion f0

| CPUDewican ord poadare \ Tender wiegrrmenl My be C2rne b camel Sa s exia g

C_148_USB Postion 1

———— . st i etentes B Basinns s

Menl i System Check
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3.12

Device Finder

Der Device Finder bietet die Moglichkeit, alle Matrizen oder SNMP-
Baugruppen, die sich im selben Subnetz befinden, anzuzeigen. Dies ist
beispielsweise hilfreich, wenn eine IP-Adresse einer bestimmten Matrix
nicht bekannt ist, aber auch auf diese Matrix via IP zugegriffen werden
soll.

Sie haben folgende Md&glichkeit, die Funktion aufzurufen:

T
G

e

Folgende Gerate-Informationen werden im Device Finder angezeigt:

Information Bedeutung

Device Bezeichnung des Gerats

Name Bezeichnung der aktiven Konfiguration
IP address Aktuelle IP-Adresse des Gerats

MAC Address MAC-Adresse des Gerats

Type Geratetyp

In der letzten Spalte des Device Finders lasst sich Gber den Button
Connect ein direkter Zugang zur jeweiligen Matrix herstellen.

Um den Device Finder zu starten, gehen Sie wie folgt vor:
C Wahlen Sie in der Symbolleiste das Symbol Device Finder.

D ior Fimitey

| Avaabie KVM devices wine the local natwors SroadrastMekicast B > o220 =
| Dwice Manrw LS T WAC Adtrass e Wb

o N Cormect
| a2 » Canoans
| a3 f Cymmn
| 5 o Cornet
| 95  Canman
1 M\ Dase
Menl i Device Finder
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4 Installation

4.1 Lieferumfang prufen

Priifen Sie, ob folgende Teile im Lieferumfang enthalten sind:
Draco tera-Matrix
1x Netzanschlusskabel pro eingebautem Netzteil
1x serielles Steuerkabel
Montagezubehdr
Quick-Setup

Sollte etwas fehlen, setzen Sie sich mit lhrem Handler in Verbindung.

4.2  System anschliel3en

Erstanwendern empfehlen wir, das System zuerst in einer Testumgebung
aufzubauen, die sich auf einen einzelnen Raum beschrénkt. Probleme bei
der Verkabelung lassen sich so leichter finden und lésen.

Matrix in Betrieb nehmen

1. Installieren Sie die CPU- und die E/A-Karten.

2. Verbinden Sie Maus, Tastatur und Monitor mit der CPU-Karte der
Matrix.
Stellen Sie die Spannungsversorgung zur Matrix her.

Offnen Sie das OSD uber das Tastatur-Kommando <'Hot Key'>, <o>
und loggen Sie sich mit Administratorrechten im Hauptmenu unter
Configuration ein (siehe Kapitel 5.2.1, Seite 67).

5. Nehmen Sie die gewiinschte Erstkonfiguration vor.

Nach der Konfiguration des Systems empfiehlt es sich, die Konfiguration
unter Configuration > Save abzuspeichern und Restart Matrix
auszufihren.
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